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1

Introduction



This section provides translators and project managers with information on the workflow between

WorldServer projects and translation kits and Trados Studio 2021. Even thoughWorldServer also works

with previous Trados Studio versions, such as SDL Trados Studio 2019 or 2017, we recommend that you

upgrade to the latest Trados Studio version for best performance. See the “Information Overview” on

page 2 and “Audience” on page 3 topics for more details on the structure of this section.

Information overview

WorldServer can create a specialWorldServer project package for Trados Studio.

While similar in concept to a project package created in Studio, theWorldServer project package differs

in its internal structure, and its filename has a different file extension, .WSXZ.

As a project manager assigned to work on aWorldServer project, you may be responsible for creating

WorldServer project packages as described in “WorldServer Project Package Creation” on page 5. You

might also be responsible for processing and importing results packages, as described in “Returning

CompletedWork toWorldServer” on page 21.

As a translator or reviewer, you obtain and open aWorldServer project package as described in “World-

Server project packages and Trados Studio ” on page 13. You translate or review the files in that

package as you would any project in Trados Studio 2021. On finishing your work, you create a return

package and upload it toWorldServer, or you return the package to whomever is responsible for

importing it. TheWorldServer return package also has the file extension .WSXZ.

Required app to enable support forWorldServer files

Starting with the 2021 release, Trados Studio has migrated support forWorldServer packages to a

dedicated app available from the RWS AppStore. TheWorldServer Compatibility Pack for Studio app

installs as an add-on to Trados Studio and enables you to open and work with WorldServer projects and

packages in Trados Studio 2021 and later.

To install the app fromWorldServer:

1. Open the Add-ins tab and select RWS AppStore.

This opens the RWS AppStore on the Installed Plug-ins page.

2. TypeWorldServer Compatibility Pack for Studio in the search box and press Enter.

3. Select the app and click the Install icon in the app description on the right-hand side of the RWS

AppStore page.

4. When WorldServer finishes downloading the app, the following confirmation message is displayed:
Download complete. Restart Trados Studio to finish installing the plug-ins.
Click this confirmationmessage to go to your specified Downloads location and run the app installer.
By default, this is %AppData%\SDL Community\AppStore Integration\Downloads.

5. Double-click on the downloadedWorldServer Compatibility Pack for Studio app and run the

installer.

ClickOK to close the prompt that confirms that the installation succeeded.

6. Restart Trados Studio after closing all active sessions.

7. Go to the Projects view in Trados Studio and check that the WorldServer group has been added to

the Home tab.

1 Introduction
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You can now open Trados Studio project packages and create WorldServer return packages from Trados

Studio.

Audience

This manual is for people who are involved with projects that use Trados Studio 2021 in conjunction

with WorldServer, and perform two different types of roles: translators and reviewers, and project

managers.

• Translators and reviewers open and work withWorldServer project packages, and then return the

results back toWorldServer.

• Project managers create and distributeWorldServer project packages. They can also process and

manually import results packages intoWorldServer.

Note: These tasks may be performed by the same person.

This manual assumes that the reader is familiar with Trados Studio 2021. For more information, see the

Trados Studio Online Help .

1Introduction
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2

WorldServer Project Package

Creation



Depending on the procedures followed by your employer or business partner who usesWorldServer,

project managers may be able to access thatWorldServer system to create and distribute a project

package created byWorldServer.

WorldServer ProjectWorkflows

InWorldServer, most work is performed within aWorldServer Project that represents work associated

with a translation effort for a single target locale. TheWorldServer project consists of one or more tasks

running through a specificWorldServerworkflow. Each task represents a single file (known inWorldServer

as an “asset”) that the workflow processes.

In its simplest form, aWorldServer workflow consists of an ordered set of automated and manual (that

is, “human”) steps. Here is an example:

This workflow contains two automated steps (“Clear Segment”and“Segment Asset”) that prepare the

file for translation. It also contains two human steps, “Translate”and“Review.”Most production

WorldServer workflows contain many automated and human steps that may include quote preparation,

pre-translation work, translation, review, quality assurance, file delivery, etc.

In the workflow definition, the workflow designer assigns each human step to one or more registered

WorldServer users. During task processing, whenWorldServer reaches a human step it notifies all

assignees by sending each of them an email message that contains a link to theWorldServer task. To

work on an assigned task, an assignee can click the link in this email message, log intoWorldServer, and

then create and download aWorldServer project package to use in Studio. Or, the assignee might

send aWorldServer project package to a colleague or business partner as an attachment to an email

message or via an FTP server. Once someone edits/translates online or exports the package, the task is

automatically claimed by that user inWorldServer, so that no one else can alter it. Claiming is also

important, as it is required in order to return the package and/or to make live TM updates, when that

option is enabled.When the assignment is complete, the assignee creates aWorldServer return package,

uploads it back onWorldServer from Studio or sends it to the project manager to manually import it

intoWorldServer and then move the task to the next step in the workflow.

2 WorldServer Project Package Creation
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MostWorldServer workflows include both a “Translate” step and a“Review”step.When theWorldServer

user assigned to the “Translate” step completes that step inWorldServer, the workflow reaches the

“Review” step, which it assigns to WorldServer users who are identified as reviewers for the target

language of the project. As did the translator, a reviewer obtains aWorldServer project package to open

in Studio.

About translation kits

WorldServer translation kits (or project packages) for Trados Studio have the .wsxz file extension. They

contain the information needed to translate or review translations of files managed in WorldServer.

In Trados Studio, you can view project information and associated metadata in the Projects view, in the

Project Attributes tab. You can also see real-time updates to the project in WorldServer as you work

through it in Studio. Each update to a segment or translation memory will be immediately reflected on

the WorldServer side, provided that you have the necessary permissions. If not, the project manager

gathers the information and brings it back into WorldServer.

The following restrictions apply to real-time updates:

• WorldServer needs to be in Live TMmode.

• In Trados Studio, you need to configure the translation memory to be updated after each change.

• Changes to source segments are not supported.

• Split and merged segments will not be updated.

• Any changes to tags will not be updated.

• Offline mode is not supported.

• Segments that were originally locked will not be updated.

A typical package that you export fromWorldServer contains:

Object Notes

A segmented representation of each source file. Each source file is converted into an .sdlxliff
file. For example, if you export a file called
Test.docx, it will be represented in the exported
package as Test_docx.sdlxliff.

The server-based TM assigned to the WorldServer
project.

This offers real-time access to the version of the
TM available on the WorldServer system. The
WorldServer TM is enabled by default in the list of
translation memories applied to the project and it
can be updated while confirming the translations
in Studio. This TM is only available for WorldServer
packages opened with Studio 2015 or later and
only for Studio users with the required
WorldServer credentials.

2WorldServer Project Package Creation
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Object Notes

The file-based TMs assigned to the WorldServer
project.

These are the offline version of the TMs assigned
to the WorldServer project, as they were available
when the WorldServer project was created. Studio
users who do not have access to the server-based
TM can use these TMs when translating the files in
the WorldServer package. The changes to these
TMs can be updated by the WorldServer project
manager when importing the return package into
WorldServer.

WorldServer terminology entries WorldServer includes a single project .tbx file
that contains relevant TD entries, if they exist.
When you open the WorldServer project package
in Studio, this .tbx file is imported into a new
Studio termbase file named WorldServer.sdltb
and is automatically included in the Studio
project. The TD Name field in the imported TD in
Studio is displayed in the Term Recognition
window by default. When it is present, the
termbase file includes information about
individual terms:

• Term statuses such as Proposed, Approved,
Preferred, Deprecated and Rejected.

• Task attributes and metadata information for
use by the project manager.

• System attributes such as Created On,
Created By, Modified On, and Modified By.

• Term and entry custom attributes, which are
mapped to Studio attributes.

Task information and associated metadata for
each file in the package.

In Trados Studio, you can view task information in
the Files view, in the Files Attributes tab.

The Studio QA Checker profile settings. In WorldServer, the main use of Studio QA
Checker profiles is to ensure consistency in terms
of length, punctuation, numbers, and so on when
exporting .wsxz translation kits for Trados Studio.
For example, if you split the files in a WorldServer
project into multiple translation kits and pass
them on to multiple Studio users (who may use
different QA Checker settings), the Studio QA
Checker profile ensures that the translation quality
is consistent across all the files in the project. You
cannot modify Studio QA Checker profiles in
WorldServer, nor can you use them to perform QA
checks. The only QA Checker that you can use in
WorldServer is the default WorldServer QA
Checker.

To use a Studio QA Checker profile in WorldServer,
you need to upload it from the location where you
exported it from Trados Studio.

2 WorldServer Project Package Creation
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Object Notes

The TM penalties defined in WorldServer for a TM
or for a TM sequence.

Knowing the penalty score that the WorldServer
project manager defined for each TM ensures that
Studio users can assess the reliability of translation
unit in a WorldServer TM. The TMs in a
WorldServer TM sequence are listed individually in
Studio and ordered by the priority set in
WorldServer.

The TM attribute mismatch penalties are applied
in Studio the same way as they are applied in
WorldServer when the mapped metadata of the
TMmatch does not match the mapped metadata
of the asset being translated.

Translation quality assessment (TQA) profiles,
starting withWorldServer 11.3.

The error types and error severities configured in
the quality model of the WorldServer project are
converted automatically to categories and
severities when users open the package in Trados
Studio. The errors reported in Online Editor and in
BrowserWorkbench are also displayed in Trados
Studio. For TQA profiles to be included in
WorldServer packages when you export them,
make sure that the project type has a
corresponding quality model.

Note: InWorldServer 11.3.0, the tasks that you
want to export also need to be in the Review step
or in another step that has the Review step type
configured in the workflow. This requirement has
been removed starting withWorldServer 11.3.1.

Note: The File Type Support (FTS) Server cannot specify segments to be excluded for the .wsxz export
format.

Options for Creating the Project Package

Use yourWeb browser to log into theWorldServer system which has projects assigned to you.

Note: The owner of theWorldServer installation must establish a user account for you, and provide you

with theWeb address (URL) of theWorldServer system and your Username and Password credentials.

When you point your browser to theWorldServer URL and enter your login credentials, WorldServer

displays its Home Page.

A message on theWorldServer Home Page displays the number of projects and tasks currently assigned

to you.

2WorldServer Project Package Creation
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To see your assignments, select the number of assigned projects in this message.WorldServer displays

the Projects page that shows each of your assigned projects.

The Projects Page—Selecting a Single Project

About this task

To work on only one of your projects:

Procedure

1. Select one of your assigned projects.

2. In theWorldServer toolbar, click Translate...

WorldServer displays the Create Translation Kit for Projects window. For each file in the project,

WorldServer:

• Claims the associated task for you, to prevent other users from working on the same file

• Locks the target file, again to prevent conflicting updates

• Formats the source file for translation

• FindsWorldServer translation memory andWorldServer terminology matches for the file

WorldServer then gathers all of this information into a project package and downloads that package

file through your browser. The filename conforms to this format: tasks_projectname_project#
_target-locale_xliff.wsxz.

3. Save this file to a known location on your PC. (Do not select the default operation, which is to open

the project package directly in Studio.)

Note: You can also create a project package by selecting a single project and clicking Export, as

described in the Selecting Multiple Projects topic. This results in a single archive file named
xliff_projects.zip.

The Projects Page—SelectingMultiple Projects

2 WorldServer Project Package Creation
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About this task

To work on two or more of your projects:

Procedure

1. Select any of your assigned projects, and then click Export. WorldServer displays the Create

Translation Kit for Projects window.

2. Accept the default format, WSXZ, and clickOK. For each file in every selected project, WorldServer

• Claims the associated task for you, to prevent other users from working on the same file

• Locks the target file, again to prevent conflicting updates

• Formats the source file for translation

• FindsWorldServer translation memory andWorldServer terminology matches for the file

WorldServer then gathers all of this information for each project into a project package file and

then gathers all of the project package files into a single archive file named xliff_projects. zip.
WorldServer then downloads that zip file through your browser.

3. Save this file to a known location on your PC.

TheTask List Page—Selecting Tasks within a Project

About this task

Instead of selecting one or moreWorldServer projects, you may want to package some or all of the

individual tasks within aWorldServer project. Each task is associated with a single file in theWorldServer

project. To select individual tasks:

Procedure

1. In yourWeb browser, log intoWorldServer.

2. Click the Assignments tab. Then click Projects.

WorldServer displays the Projects page that lists projects assigned to you.

3. Click the name of the Project whose tasks you want to see.

WorldServer displays the Task List for Project page for the selected project.

4. Select one or more tasks. To select all of the tasks in the project, click the checkbox in the header

bar of the task list.

5. Position your mouse over the expansion triangle at the right side of the Edit/Translate button.

WorldServer displays a menu of supported editors.

6. Click In Trados Studio...

WorldServer displays the Create Translation Kit for Projects window. For each selected task,World-

Server:

• Claims the task for you, to prevent other users from working on the same file

• Locks the target file, again to prevent conflicting updates

• Formats the source file for translation

• FindsWorldServer translation memory andWorldServer terminology matches for the file

2WorldServer Project Package Creation
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WorldServer then gathers all of this information into a project package and downloads that package

file through your browser. The filename conforms to this format: tasks_projectname_project#
_target-locale_xliff.wsxz.

7. Save this file to a known location on your PC. (Do not select the default operation, which is to open

the project package directly in Studio.)

TheWorldServer Task Assignment Email Message

About this task

If you have a user account on aWorldServer system in which you are assigned a task,WorldServer

notifies you of that assignment by sending an email message. The message begins, “You have just
been assigned task(s) for project(s) listed below...” It contains a link to the WorldServer
page that lists the assigned task(s) for each project assigned to you.

If you receive aWorldServer task-assignment message, you can create aWorldServer project package for

an assignment:

Procedure

1. In the email message, click the link to aWorldServer assignment.

WorldServer displays its Login page.

2. Enter your login credentials, and click Login.

WorldServer displays the Task List for Project page for the assigned project.

3. Select one or more tasks. To select all of the tasks in the project, click the checkbox in the header

bar of the task list.

4. Position your mouse over the expansion triangle at the right side of the Edit/Translate button.

WorldServer displays a menu of supported editors.

5. Click In Trados Studio...

WorldServer displays the Create Translation Kit for Projects window. For each selected task,World-

Server

• Claims the task for you, to prevent other users from working on the same file

• Locks the target file, again to prevent conflicting updates

• Formats the source file for translation

• FindsWorldServer translation memory andWorldServer terminology matches for the file

WorldServer then gathers all of this information into a project package and downloads that package

file through your browser. The filename conforms to this format: tasks_projectname_project#
_target-locale_xliff.wsxz.

6. Save this file to a known location on your PC. (Do not select the default operation, which is to open

the project package directly in Studio.)

2 WorldServer Project Package Creation
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3

WorldServer project packages and

Trados Studio



Translators and reviewers may receive aWorldServer project package as an attachment to an email

message, or might download the project package from an FTP server. Opening theWorldServer project

package in Trados Studio 2021 creates a new Studio project or updates an existing project.

Each time you open an updated project package created inWorldServer 11.1 or later with Trados Studio

2021, the existing project is updated in Studio. However, in SDL Trados Studio versions earlier than

2017, Studio creates a new project each time you open the same project package.

Note: RWS recommends that you only openWorldServer project packages with Trados Studio 2021.

While it is possible to open aWorldServer project package file directly from yourweb browser's download

dialog box or by double-clicking it inWindows Explorer, doing so may lead to unexpected results.

Add-on required

Trados Studio 2021 and later requires the Compatibility andMigration Power Pack to enable support

forWorldServer blingual files and packages, including Live TM connections.

To install the app, go to the Add-Ins tab > RWS AppStore or visit https://appstore.rws.com .

Project Package Formats

You can receiveWorldServer project packages in two different formats, one of which requires an

extraction step.

• A file named xliff_projects. zip that can contain one or more project packages. In this case,
you extract the project packages files (which have a file extension of .wsxz) from the .zip file and
save them to a known location on your PC. You open and work with a single project package at a
time.

• A file with the format tasks_projectname_project#_target-locale_xliff.wsxzwhich

contains a single project package. You open this file directly in Studio.

Opening the Package
Before you begin

• Make sure you have installed theWorldServer Compatibility Pack for Studio before working with

WorldServer packages in Trados Studio 2021 and later.

• Make sure you know the location of theWorldServer project package file (which has a file extension

of .wsxz) on your PC.

3 WorldServer project packages andTrados Studio
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About this task

To open aWorldServer project package:

Procedure

1. Start Trados Studio, and then select File > Open > Package..., or click the Open Package

button in the standard toolbar).

2. Navigate to theWorldServer project package file, and select it.

3. ClickOpen.

The ConvertingWorldServer Settings page is displayed. On this page, you can choose toGenerate

translation and analysis statistics to perform the Analyze Files task and get the Analyze Files

report for the files included in the package.

4. Click Next.

5. Choose an empty folder in the Project Folder field and click Finish.

6. When the package import preparation is complete, click Close.

7. You are now ready to work on the project files in Trados Studio 2021. To enable real-time updates

between Studio andWorldServer, go to theOptions dialog box, select Translation Memory and

Automated Translation and check Update next to the TM that you are using to translate this

package. This can be configured ifWorldServer is in Live TMmode.

Results

Studio imports the contents of theWorldServer project package and displays it in the Projects view.

For projects created inWorldServer with the url_of_origin property configured, Studio shows the

WorldServer location of the project in the Server column of the Projects view.

Note: Studio truncatesWorldServer project or filenames longer than 50 characters. Even with this

change, Studio cannot openWorldServer packages if the temporary folder path or the project names

exceed 260 characters. To avoid exceeding this limit, change your temp and tmp folders to a top-level
folder, such as C:\TMP.

Translation and Review forWorldServer

Projects

After you import aWorldServer project package, you can translate or review the files in that package as

you would the files in any Trados Studio 2021 project package. If WorldServer found any translation

memory matches for segments in the project files, it includes in theWorldServer project package a TMX

file that Studio imports into a project translation memory (TM) whose name is WorldServer.

3WorldServer project packages andTrados Studio
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Behavior Differences

When you work with files in aWorldServer project package, you need to recognize some differences in

behavior betweenWorldServer and Trados Studio, including the following:

• Segment Comments

• Segment Status

• Segment Locking

• Word Counts and TM Leverage

• Inline Tags

• Preview Capabilities

• Due Dates

Segment Comments

SDLTrados Studio SDLWorldServer

Comment Scope File, segment, and range
comments

Note:When you select text
within a segment and then
create a comment whose scope
is Current Selection, Studio
identifies this as a range
comment.

Segment comments.
WorldServer converts range
comments to segment
comments, and ignores file
comments

Comment Severity Comment Severity Level [Not available]

Comment Grouping Comments stored individually
and tagged with user, date and
time

All comments for segment saved
in one text block. Each is
preceded with a separator that
contains user, date and time

Segment Status

Trados Studio andWorldServer use different values to identify translation segment status. When you

open aWorldServer project package or create aWorldServer return package, segment status values are

converted as follows:

When you export a translation kit (WorldServer project package) fromWorldServer

WorldServer Trados Studio

No Status (empty target) Not Translated

No Status (non-empty target) Draft

Pending Review Translated

3 WorldServer project packages andTrados Studio
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WorldServer Trados Studio

Reviewed Translation Approved

Rejected Translation Rejected

When you import a translation kit (WorldServer return package) from Studio

Trados Studio WorldServer

Not Translated No Status

Draft No Status

Translated Pending Review

Translation Approved Reviewed

Translation Rejected Rejected

Sign-off Rejected Rejected

Signed Off Reviewed

Note:When the real-time segment update is enabled and you confirm a segment :

• The segment status inWorldServer is set to Pending Review if the Studio editor is open for translation

(since the segment status in Studio is set to Translated when it's confirmed)

• The segment status inWorldServer is set to Reviewed if the Studio editor is open for review (since

the segment status in Studio is set to Translation Approved when it's confirmed)

Segment Locking

InWorldServer, a workflow step may lock target segments whose translations it retrieves from TM.

WorldServer supports two types of segment locks:

• Dynamic locks allow you to unlock and modify segments

• Static locks do not allow you to modify segments Trados Studio does not distinguish between

these lock types.

When you edit a file with locked segments in the Studio side-by-side editor, you will see a lock icon in

these segments. While Studio allows you to unlock and modify a locked segment,WorldServer will not

accept any changes to the contents of segments that it locked with static locks. If you attempt to modify

a static-locked segment, the Editor displays a warning message.

However, depending upon yourWorldServer user privileges, you may be able to add or edit comments

associated with static-locked segments. To do so, unlock the segment and add or edit the comment.

When you confirm that segment, if the lock is a static one, you will have one of two options:

Commenting allowed on locked segments

The Editor displays a warning message to inform you thatWorldServer will accept changes to the

comments, but not to the segment translation

3WorldServer project packages andTrados Studio
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Commenting prevented on locked segments

The Editor displays a warning message to inform you thatWorldServer will not accept either your

comment changes or any segment translation changes

A similar issue occurs in the Editor if youmodify and then lock a segment that is not locked inWorldServer.

When you confirm the segment, the Editor displays a warning message to warn you thatWorldServer

will not honor this segment lock.

Word Counts andTM Leverage

Youmay find differences in word counts and translationmemorymatch scores (leverage) betweenTrados

Studio andWorldServer, since they currently use slightly different approaches to segmentation and

leverage. The differences should not be significant.

Trados Studio will correctly display fuzzy match percentages after opening a translation kit from

WorldServer.

Inline Tags

WorldServer and Trados Studio both show nontranslatable markup within segments as numbers

enclosed within braces, such as {1}. WorldServer does not distinguish among different types of these

inline tags; it refers to all of them as placeholders.

In each segment, placeholders in the target must match placeholders in the source. You can move

placeholders within a segment, but must not add or delete them. If placeholders are missing, or there

are more placeholders in the target segment than in the source segment, you cannot create aWorld-

Server return package.

Tip: It may make sense in some cases to move a placeholder, for example, if the sentence structure of

the source language differs from that of the target language. However, sometimes moving a placeholder

can make the file invalid. For example, if you are working with an HTML or XML file and you swap the

order of an opening tag and a closing tag, the file no longer contains valid HTML or XML.

Preview Capabilities

The preview feature of Trados Studio (View > Preview) displays assets contained in WorldServer

packages that have text, HTML, and XML formats. The preview is available for the original file format

associated with the following MIME types:

• Text

• text/plain

• text/x-java-properties

• application/x-javascript

• HTML

• text/HTML

• application/x-jsp

• text/x-asp

• XML
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• text/xml

• text/xsl

• txt/x-idiom-dcr+xml

Project Package Due Dates

The task step due dates inWorldServer are used for Trados Studio project packages, but only when the

due date for each task in the project is the same. Otherwise the due date in Studio is set to null.

Note: If the task step due date is specified without time, for example 1/23/10 instead of 1/23/10 03:30

PM, the time is automatically set to 5:00 pm.

Creating the translation return package

When you are ready to return the results of your work to theWorldServer system on which the project

was created, you begin by creating aWorldServer return package in Trados Studio 2021.

Before you begin

To createWorldServer return packages in Trados Studio 2021 and later, make sure you have installed the

WorldServer Compatibility Pack for Studio from the RWS AppStore.

To install the app, go to the Add-Ins tab > RWS AppStore or visit https://appstore.rws.com .

About this task

Follow these steps:

Procedure

1. Be sure to save the files in your project.

2. Select Project > Create Return Package.

3. Select the files to include in the return package, and click Next >.

4. Specify a return package location, which could be the default URL ofWorldServer or a File. Studio

adds the file extension .wsxz to indicate that this is aWorldServer return package.

Note: An entry in the Comments field is used only if you later create a draft email message when

creation of the WorldServer return package finishes. WorldServer does not use or retain the

comments.

5. Click Finish.

Studio creates theWorldServer return package and displays its Create Return Package dialog box.

6. To display any errors, click Show Results.

7. You can open the folder in which you saved theWorldServer return package and create a draft

email message with theWorldServer return package attached, or simply click Finish to close the

dialog box.
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4

Returning CompletedWork to

WorldServer



Automatically Uploading the Return Pack-

age from Studio
About this task

Follow these steps to automatically uploadWorldServer return packages toWorldServer.

Procedure

1. Select Project > Create Return Package from the menu bar. The Create Return Package

wizard is displayed on the Select Files page. All files in the project are included in the list, apart from

reference files.

Note: If you select files that were not originally received in a project package, the Create Return

Package option will be disabled (grayed out).

2. Select or clear the check boxes next to the file names on the Select Files page to include or exclude

them from the package. If you have previously included any of the files displayed in another return

package, those files will not be selected by default.

3. Click Next.

4. Choose Server or File on the Return Package Options page.

Note: If the package was created inWorldServer and the url_of_origin setting was configured
by theWorldserver administrator, Studio automatically recognizes the server where the package
came from. The Server field shows the server of origin so that you can upload the return package

back to its original location onWorldServer.

For packages created in earlier versions, or for which the url_of_origin setting was not config-

ured, manually enter the server address in the Server field.

5. Click Authentication to enter your credentials for the specified server address.

6. If you want to add a comment to the return package, enter it in the Comment box.

7. Click Finish to create the package and go to the Creating Return Package page. Studio creates the

return package and uploads it toWorldServer. Once the package creation is complete, the statuses

next to the progress bars change to Completed.

After the return package is created, the manual task assigned to the files in that package is displayed

as complete in the My Tasks folder on the navigation tree of the Files view.

8. To complete the assigned workflow tasks whose files you imported, select the tasks and click

Complete.

WorldServer displays the Complete Task(s) page and moves the tasks to the next step in their

workflow.

9. The Next Step field lists each available path in the workflow. Select the appropriate next step, enter

a comment for the next person assigned a workflow step in this task, and clickOK.

If you are assigned the next human step in the workflow, the tasks remain on this Task List for

Project page, and the step name changes to identify the new step. Otherwise,WorldServer removes

the tasks from this page because they are no longer available to you.
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Manually Importing the Return Package

fromWorldServer

If you are a project manager and you received a return package from a translator who does not have the

access to automatically upload the return package from Studio, you can log intoWorldServer and

manually import the return package. You can also specify now if you want to update theWorldServer

translation memory with the changes that the translator made in Studio.

About this task

Follow these steps to importWorldServer return packages intoWorldServer.

Procedure

1. Log into theWorldServer system on which the project was created. You can enter the URL of this

system directly in yourWeb browser, or you can click the link in aWorldServer task assignment email

message that you received.

2. Enter your login credentials, and click Login.

If you clicked the link in aWorldServer task assignment email message,WorldServer displays the

Task List for Project page for this project.

3. If you entered theWorldServer URL in your browser, WorldServer displays its Home page.

a. Click the Assignments tab, and then click Projects.

WorldServer displays its Projects page.

b. Click the name of the project whoseWorldServer return package you want to import.

WorldServer displays the Task List for Project page for that project.

4. Click Import...

WorldServer displays the Import OfflineWork page.

5. Click Browse.

6. Navigate to and select theWorldServer return package file.

7. If you are authorized to update theWorldServer translation memory, you will see the Update the

translation memory using imported assets checkbox. If so, and you want to update the

WorldServer TM, select this checkbox.

8. Click Import.

WorldServer confirms that you claimed the task(s) whose files you are importing, and that the files

are locked in your name. It then imports the target file(s) and, if appropriate, updates translation

memory.

9. To complete the assigned workflow tasks whose files you imported so thatWorldServer can move

them to the next step in their workflow, select the tasks and click Complete...

WorldServer displays the Complete Task(s) page.

10. The Next Step field lists each available path in the workflow. Select the appropriate next step, enter

a comment thatWorldServer presents to the next person assigned a workflow step in this task,

and clickOK.

If you are assigned the next human step in the workflow, the tasks remain on this Task List for

Project page, and the step name changes to identify the new step. Otherwise,WorldServer removes
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the tasks from this page because they are no longer available to you.
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5

External review documents



Reviewers can use the bilingual .docx format to evaluate assets outside of WorldServer or Trados

Studio. External review documents provide limited access to target translation segments processed by

file types.

The external reviewdocument kit consists of one ormore .docx files.You export and import the bilingual
.docx file either directly from the user interface or through automatic actions. You can export any type
of asset as a bilingual .docx file for external review, and then import that file back into WorldServer after

the review.

The following workflow gives another example of how you can use WorldServer and Studio to work

with an external reviewer:

Adding Studio to the translation and review workflow gives you several options:

• Reviewers can return their .docx changes to Studio translators, who have access to track changes

markup.

• You can also choose to export a .wsxz project package fromWorldServer, and then export and

import the external review file from Studio.

Notes on the bilingual .docx format

If your WorldServer administrator has configured the bilingual .docx format as one of your system
options, you can create .docx files for reviewers either from the user interface or through automatic
actions.

From the user interface

On the Tasks page, select the source assets that you want to export and select Export on the ribbon. In

the Create Translation Kit for Tasks dialog box, select the bilingual .docx format, and then select Export.

Through automatic actions

Use export and import automatic actions (AAs) inside a workflow to specify the bilingual .docxformat

for a translation kit. When the workflow runs, WorldServer produces the review file at the appropriate

step.When your reviewers are done, you give the file back to WorldServer in the import step.

Note the following about exporting and importing bilingual .docx files:
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Exporting Importing

• For assets originally in .docx format, in
WorldServer, configure your MicrosoftWord
file type to apply tracked changes before
opening. Thus, you can see tracked changes
in WorldServer when you work with the
translated asset.

• The export process creates a bilingual .docx
file whose filename consists of the
WorldServer folder name and a long
numerical identifier.

Note: You can only export assets to this format if
they were segmented by regular file types. You
cannot export assets segmented by legacy filters.

• The name of the file must be the same as
when you exported it.

• The import will only change the existing
target translations for the assets.

• A second import of the same file has no effect
on the assets.

• Sub-segment comments are elevated to
segment-level comments upon import, as is
the case for any imported Studio kit.

• The status of updated segments becomes No
Status.

• If segments with track changes are saved in
translation memory, WorldServer removes
the REVISIONMARKER placeholders and the
deleted strings. In other words, the TM
segment is stored as if all track changes were
accepted.

• If some segments contain tracked changes
and if the original asset format is .docx, the
target asset contains tracked changes. For any
other asset format, tracked changes may
result in illegible text.

How to review bilingual .docx files

Reviewers without access to WorldServer or Trados Studio can open bilingual .docx files in Microsoft

Word and edit target segments as needed. Translators who use Trados Studio can make the required

changes and integrate them back into a WorldServer project package.

Review inWord

When you review a bilingual .docx file inWord, note that you can only change the existing target
translation for any segment. Other changes (including added content to blank target translations) are
ignored on import.

Note: For any format besides .docx, imported track changes may result in illegible text.

Translation and review in Studio

When you use Studio to work with bilingual .docx files, you have the full range of Studio translation

tools available. In Studio, you can identify placeholders that represent tracked changes, because it

updates segments as Deleted and Inserted strings, enclosed in the following placeholders:

• <SDL:REVISIONMARKER – Delete>, </SDL:REVISIONMARKER – Delete>

• <SDL:REVISIONMARKER – Insert>, </SDL:REVISIONMARKER – Insert>

In Studio, you can also compare reviewer comments against the translation memory and the rest of the

assets in the project package before creating the WorldServer return package.
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Note: In BrowserWorkbench, the placeholders that represent tracked changes are identical to the

placeholders that represent formatting, which might make it difficult to distinguish between them.
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A

WorldServer Administrator

Information



This appendix contains configuration or other information forWorldServer administrators that may

affect work for Trados Studio project managers or translators/reviewers.

Segment Status Default Change

In releases after SDLWorldServer version 9.4, the set_translation_statuses default (in the tm.
properties file) has been changed from False to True. Trados Studio users may notice the following
affects on segment status:

• Segments translated with ICE matches will be marked as Reviewed inWorldServer, which corre-

sponds to an Approved segment status in Studio.

• 100%matches will be marked as Pending Review inWorldServer which correspond to a Translated

segment status in Studio.

These status changes allow Studio to more accurately reflect your translated leverage.

The default setting change affects assets segmented by both legacy and FTS filters. WorldServer

customers who are running in Live TMmode will not be affected, as this setting is implicitly True for
Live TMmode.

Without enabling this setting, segments won't reflect that they are context matches until they are

moved out of Draft status.

Note:WorldServer administrators can edit the tm.properties file to achieve the same status and

leverage inWorldServer 9.2 and 9.3. See theWorldServer Translation Memory Mode Concepts Guide. If you

plan to keep your own version of the tm.properties file when you install WorldServer 9.4, we
recommend that you change this setting to obtain the listed benefits.
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B

Studio User Notes



Trados Studio has its own, very complete, set of user documentation. The following notes describes

aspects ofWorldServer of particular interest to Studio users.

Starting withWorldServer 2011, version 10.1,WorldServer integration with Studio includes the following

areas:

• Relaxed tag parity

• WorldServer translation plug-in

Please see the Trados Studio documentation for complete descriptions of Studio features.

Relaxed tag parity

Startingwith SDLTrados Studio 2011 andWorldServer 2011 (10.2.1), WorldServer relaxes the requirement

for tag parity in translation units by default. In other words, some tags may be present in the target

text without necessarily being in the source text and vice versa.

Trados Studio creates return packages for WorldServer without enforcing tag parity. Note the following:

• Translation units which contain out-of-parity tags are excluded from in-context exact (ICE) matches

in WorldServer.

• WorldServer resolves target-only tags through an automatic mechanism in the associated file type

configuration.

If you do not want to verify tag parity in source and target translation units in Trados Studio, configure

the TagVerifier settings by going to File > Options > Verification > TagVerifier > Common.

WorldServer Translation Plug-in for Studio

Starting with SDL Trados Studio 2014, the translation memory (TM) attached to a WorldServer package

is centrally shared betweenWorldServer and Studio.When opening aWorldServer package, Studio users

with access to the WorldServer system also have real-time access to the server-based TM attached to

the package. This means that they can always see the most up-to-date version of the TM and update it

in real time, while confirming the translations in Studio.

The translation plug-in has the following limitations:

• The default WorldServer scoping mode is always used for scoring purposes.

• Not all penalties or penalty values are currently applied or displayed correctly, because WorldServer

penalties need to be mapped to Studio penalties; at the moment, there is no 1:1 correspondence

between them.

• For concordance searches, WorldServer scoring rules are applied, which differ from the rules used

by Studio. (WorldServer's Studio-aligned TMmode only applies to standard leverage scoring, not to

concordance scoring.)

Note: For previous supported versions of Studio (if available) and for packages created in earlier

versions of WorldServer, Studio users only have access to the offline version of the TM. This is the version

of the TM that was available when the WorldServer project was created. For more information on the

plug-in, see the Studio documentation.
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